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A: General Guidelines for Peptide Mapping Workflows
1. Overview of Applications and Workflows
2. Common Activity Nodes for all Peptide Mapping Workflows:

• Data Upload
• Data Preparation
• Peptide Mapping Search
• Data Review
• Export and Report Results

B: Guidelines for Specific Peptide Mapping Workflows
1. Information for Specific Workflows:

• 1.Simple Peptide Mapping 
• 2.Extended Characterization
• 3.Sequence Variant Search
• 4.Comparative Analysis
• 5.Batch Processing
• 6.Review Snapshots

Peptide Mapping Guidelines
CONTENTS OF THIS GUIDE
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Part A
General Guidelines for Peptide Mapping 
Workflows
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• Use the Peptide Mapping workflows for the analysis of enzymatically digested biotherapeutic 
molecules, for:
‒ Sequence coverage and confirmation
‒ Glycopeptide analysis
‒ Post-translational modification (PTM) analysis
‒ Target PTM profiling

• Use Pepmap workflows _Simple, _Extended, _Comparative or _SVA for replicate analyses 
with common peak boundaries across all samples.

• Use Pepmap workflow _BatchProcessing for analysis of the same or different molecules, 
with each sample treated as an individual replicate with no shared peak boundaries.

• Use Pepmap workflow _ReviewSnapshots to open saved results from other Pepmap 
workflows.

Overview of Applications for Peptide Mapping Workflows

‒ Disulfide-bond (DSB) analysis 
‒ Conjugate analysis
‒ Sequence variant analysis (SVA) 

A: 1.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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• Pepmap_Simple:
‒ A Peptide Mapping workflow for routine characterization, with identification and quantification of the most 

common modifications and glycosylations.

• Pepmap_Extended: 
‒ A Peptide Mapping workflow that has more search nodes, for identification of less common PTMs to maximize 

sequence coverage.

• Pepmap_BatchProcessing: 
‒ A version of the Pepmap_Extended workflow that analyzes each data file on a sample-by-sample basis.

• Pepmap_Comparative: 
‒ A version of the Pepmap_Extended workflow that has activity nodes to complete a differential analysis between 

sample sets.

• Pepmap_SVA: 
‒ A version of the Pepmap_Extended workflow that has more search nodes for identification of potential 

sequence variants.

• Pepmap_ReviewSnapshots: 
‒ A workflow to open or review saved results.

Peptide Mapping Workflows
A: 1.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

2. Common Activity Nodes for Peptide Mapping 
Workflows
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Example of a Typical Peptide Mapping Workflow 
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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A.  Load Raw Data → Input required*

B.  RT Range Restriction → Input required*

C.  Chromatogram View (before RT alignment)

D.  Data Preparation [Container]
i.  Chromatogram Chemical Noise Subtraction
ii.  Chromatogram RT Alignment
iii.  Chromatogram View after Alignment
iv.  Chromatogram Peak Detection
v.  Chromatogram Isotope Clustering
vi.  Singleton Filter 

E.  Peptide Identification → Input required*

F.  Review Results → Input required*

G.  Report and Export Results

Common Activity Nodes in Peptide Mapping Workflows 

vi.  Charge Grouping 
vii.  Adduct Grouping
viii. MS/MS Consolidation 
ix.  MS/MS Peak Detection
x.  MS/MS Deisotoping 

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

*Optimize settings for new samples
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• To upload raw data files, click the folder icon      . 
‒ Select container files with the format wiff or wiff2.

• If data was acquired with the ZenoTOF 7600 system, then select only the 
wiff2 format.

• Do not select the auxiliary files with the same name. 

Load Raw Data: Data Files
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• Double-click the wiff or wiff2 container to see the sample files.
• Select the samples to upload.

‒ To select samples in a wiff or wiff2 container file:

Note: For information about Batch Processing, refer to B: 5.Guidelines for Peptide Mapping Batch Processing Workflows.
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Load Raw Data: Use File Name as Sample Name
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

File Name Sample Name 

• Select Use File Name as Sample Name in Load Raw Data to use 
the File Name in the Experiment Table.
‒ If Format: Auto Detect is selected, then the Sample Name is used in the 

Experiment Table.

• The File Name of the wiff or wiff2 container file might not be the same as Sample Name in the 
wiff or wiff2 container file.
‒ The name of the Data File in the SCIEX OS software becomes the name of the wiff or wiff2 container file 

(File Name) in Biologics Explorer software.

• Individual acquisitions with different wiff or wiff2 File Names might 
have the same Sample Name.

Note: If entries in the Experiment Table have the same Sample Name, 
there can be an effect on the quantitative information reported.
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Load Raw Data: Use File Name as Sample Name
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

2. To load multiple samples from in the same wiff or wiff2 container, do not select Use File Name as Sample 
Name:

1. To load replicates that have one sample in each wiff or wiff2 container, select Use File Name as Sample 
Name:

Multiple samples in a wiff2

Single sample in a wiff2
wiff2 container file selected

Individual samples selected
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• To identify the retention time (RT) ranges that contain 
meaningful data, open (double-click) the results of Load Raw 
Data.
‒ Exclude stray signals caused by valve switching or column wash.
‒ Focus on the separation range.

Restrict the RT Range
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

5.00

∆=45.0

50.00

Note: If the fields are blank, or if RT Range Restriction has the Bypass icon 
activated, then the full RT range is used.
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Data Preparation [Container]
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• Activity nodes in the Data Preparation 
[Container] process the raw data for 
analysis.
‒ Only optimize the settings of these activity 

nodes under specific conditions, for example, 
when troubleshooting a low sequence 
coverage.

• To return to the main workflow, click the                  
__ icon. 
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Chromatogram Chemical Noise Subtraction: Smoothing
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Chromatogram Smoothing is used to improve the RT profile of 
peaks for peak detection.

• Estimator:
- Moving Average replaces the intensity of each data point with the mean 

average intensity of the data points in the RT Window. High values cause peak 
widths to increase, but peak volume is not changed.

- Binomial is an iterative form of Moving Average that has less effect on peak 
widths at high scan values.

Red: Moving Average (5 scans)
Orange: Moving Average (15 scans)
Dark Blue: Binomial (5 scans)
Light Blue: Binomial (15 scans)
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• Chemical Noise Subtraction decreases the length of long-tailing 
peaks.

• Change this setting if the default values remove too much signal.
• If too much signal if removed, it can be identified by:

• Excessive cutoff of the tails of very wide (extended RT) peaks.
• Loss of low-intensity isotope peaks from singly (+1) or doubly (+2) charged 

clusters, or from low-intensity clusters of interest:

Chromatogram Chemical Noise Subtraction
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• To decrease the amount of noise removal (keep more signal):
‒ Decrease the Quantile.
‒ Increase the RT Window.
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Chromatogram Chemical Noise Subtraction: RT Window 
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

1. Find a feature that extends over a longer RT than other features in the ion map.
2. Take a vertical slice to create an Extracted Ion Chromatogram.
3. Right-click in the Extracted Ion Chromatogram window, and then select Profiles.
4. Use the Advanced Filter Tool          to select the RT range for the peak.
5. Record the number of scans shown, and then enter at least double this value for the 

RT Window in the settings.

Take a vertical slice

• Generally, the RT Window should be at least double the number of 
scans across the largest peak in the dataset.

To calculate the number of scans:
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• If the noise level is significantly different from the Threshold value 
pre-set in the Chromatogram Chemical Noise Subtraction activity 
node, then change this setting.

• To measure the noise level and identify an applicable Threshold 
intensity value:
1. Drag the intensity axis of the mass spectrum until the noise level can be seen, 

or use the icon in the tool bar to change the axis from the linear to the 
logarithmic scale.

2. Use the crosshair tool    to measure the intensity of the noise level.

Chromatogram Chemical Noise Subtraction: Threshold
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Noise level
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Chromatogram Peak Detection: Use Peak RT Splitting

• Shoulder peaks, in the RT direction, can be detected as a single peak, or as 
multiple separate peaks.

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• Lower split sensitivity
• Fewer peaks

• Higher split sensitivity
• More peaks

‒ To increase the number of peaks detected (increase split sensitivity): 
• Decrease the Gap/Peak Ratio.
• Decrease or remove Smoothing.
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• The Distance Measure compares each experimental peak to the theoretical 
isotope profile for that peptide.

Chromatogram Isotope Clustering: Distance Measure

• Log Ratio treats all peaks in a cluster equally.
• Cosine converts each cluster into a vector, with the contribution of each peak 

relative to the abundance. Therefore, smaller peaks have less impact.

• If a peptide of interest has not been 
clustered as required, then compare 
the results of Log Ratio and Cosine.

Vectors of theoretical and 
experimental isotope clusters.

Log-Ratio

Theoretical isotope cluster.

Experimental isotope cluster.

Cosine

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS



20 of 85 © 2024 DH Tech. Dev. Pte. Ltd.

MS/MS Consolidation: Merge Across Chromatograms
• This activity node merges MS/MS data across equivalent peaks and clusters.

‒ Consolidation can improve MS/MS spectra, and increase identifications.
‒ Consolidation can decrease false positives if MS/MS spectra are too ambiguous.

• To use MS/MS data from technical replicates to increase confidence in 
identifications, select to Merge MS/MS data Across Chromatograms.
‒ Merged MS/MS data are assigned to the sample with the highest intensity for that spectrum.

• To measure individual sample sequence coverage, do not select this option.

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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MS/MS Consolidation: Extend Peak Boundaries 
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• To analyze data acquired from a TripleTOF 5600/5600+, TripleTOF 
6600/6600+, or X500B QTOF mass spectrometer, activate the 
Extend Peak Boundaries option.
‒ This setting includes MS/MS data located outside of the peak boundaries 

in the consolidation.

MS/MS data outside of the 
peak boundaries is kept.

MS/MS data outside of the 
peak boundaries is removed.



22 of 85 © 2024 DH Tech. Dev. Pte. Ltd.

MS/MS Peak Detection
• This activity node detects peak centroids in MS/MS profile data.

‒ Peak centroids are required for Peptide Mapping.

• To increase the likelihood of identifying long (high mass) peptides with EAD data, increase the 
Max. Number of Peaks to 5000 to keep more of the low-intensity MS/MS ions.
‒ The number of MS/MS peaks detected, compared to the number of MS/MS peaks used for identification, 

has an effect on the score. 
‒ To compensate for the higher number of peaks, decrease the Min. Score in Peptide Mapping.

• Note: A lower score increases the risk of false positive identifications.

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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MS/MS Deisotoping

• This activity node removes the isotopic peaks in high-resolution MS/MS data 
to give singly-charged (deisotoped) monoisotopic peaks.
‒ Deisotoping decreases the number of MS/MS peaks in the fragment spectra.
‒ The number of MS/MS peaks detected, compared to the number of MS/MS peaks 

used for identification, has an effect on the score.

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Before MS/MS Deisotoping After MS/MS Deisotoping After Peptide Mapping



24 of 85 © 2024 DH Tech. Dev. Pte. Ltd.

• Instrument: Select the fragmentation type used for data acquisition.
‒ To review or change the types of fragment ions used for identification:

• Browse to File > Tools > Instrument Editor.

Peptide Mapping: General

• m/z Tolerance: 
‒ The m/z Tolerance value is not an indicator of the instrument mass accuracy. 

It adjusts for the possible impact on the m/z of MS/MS pre-processing.
• Decrease the m/z Tolerance to decrease the number of false positive or ambiguous 

annotations.

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• Min. Score:
‒ The number of MS/MS peaks has an effect on the optimal score threshold. 

• The MS/MS score is related to the number of identified and unidentified peaks in the 
spectrum.

• Information-rich MS/MS spectra with many peaks can be confidently identified with a 
lower score.

‒ Increase the Min. Score to decrease the number of false positives or 
ambiguous annotations.
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Peptide Mapping: Sequence
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• Sequence(s): 
‒ If all samples have the same sequence, enter it in one of these formats:

• From Text: Enter the protein sequence in the Sequences box.
• From Fasta File: Select a FASTA file that contains the sequence of interest.
• From Global File: Select a FASTA file with multiple entries, and then select the sequences 

to use from the pop-up window.

‒ If different samples require different sequences:
• Use the Batch Processing workflow.

• Enzymes: 
‒ To see the list of system-configured and user-defined enzymes, 

use the + icon to open the Select Entries dialog.
‒ Adjust enzyme specificity, maximum number of missed cleavages, 

and minimum peptide length as required.

Note: For more information about Batch Processing, refer to the section B: 5.Guidelines for 
Peptide Mapping Batch Processing Workflows.
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• To edit the properties of modifications selected for a particular Peptide 
Mapping search:
1. Select all Variable or Fixed modifications to edit.
2. Use the       icon to open the Properties dialog.
‒ Select if the Unmodified peptide is required for the modification to be 

identified, and if so, how closely the two forms must elute.

Peptide Mapping: Modifications
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Modifications tab:
• To see the list of available Fixed or Variable modifications, use 

the + icon to open the Select Entries dialog.
‒ To add commonly used modifications as favorites, select the 

star     icon.

• To review existing modifications or to add custom modifications:
‒ Browse to File > Tools > Modification Editor.
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Peptide Mapping: Glycosylation (1)

• A search for multiple glycosylation sites can produce a high number of results and take a 
long time to complete. General guidance to control the search space:
‒ Max. Number of Glycans per Peptide: For the search to proceed, the predefined threshold 

number of Estimated Glycopeptide Candidates cannot be exceeded.
Note: For more information, refer to the next page: Peptide Mapping: Glycosylation Tab (2). 

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Glycosylation tab:
• Library: Select a system-configured or user-defined library.

‒ To review or change a glycan library: Browse to File > Tools > 
Library Browser > Resources.

‒ Allowed Sites: Only O-linked: The search criteria must be controlled because every serine 
(S) and threonine (T) residue is a potential O-glycosylation site. 
• Long peptides that contain many potential glycosylation sites have a large effect on the number of 

Estimated Glycopeptide Candidates, and the subsequent processing time. 
• To decrease the total number of candidates and the search time, use enzymes that create shorter 

peptides. For example, select Trypsin/P so that cleavage is not restricted at RP/KP.

‒ Allowed Sites: Only N-linked:
• Max. Number of Glycans per Peptide: The maximum allowed value is 4.
• Fewer missed cleavages and variable modifications decreases the search time.
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Peptide Mapping: Glycosylation (2)
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Glycosylation tab:
• A combination of factors is used to calculate the number of Estimated 

Glycopeptide Candidates, which controls if the search will proceed:
1. The number of glycans in the glycan library (including substituents).

• Use the smallest library size that contains the applicable glycans of interest.
• Select Filter for Core Structures to decrease the number of candidates.

2. The Max. Number of Glycans per Peptide.
• Enter the estimated number of glycans for the molecule. Larger libraries can be 

used with fewer glycans per peptide, and vice versa.
3. The theoretical sites of glycosylation on a peptide.

• The number of missed cleavages and the enzyme specificity have an effect on 
the total number of theoretical sites of glycosylation.

• Other search parameters have an effect on the overall search time. 
‒ To decrease the time to completion:

• Disable Glycan fragments in the Edit Instrument settings.
• Minimize the variable modifications and their number per peptide.
• Maximize the minimum peptide length. 
• Decrease the number of glycans per peptide.
• Decrease the size of the glycan library.

Example of permitted search combinations for       
O-glycans in Etanercept digested with trypsin:
Enzyme: Trypsin
Missed cleavages: 1

Enzyme: Trypsin/P
Missed cleavages: 0

Note: Disable Glycan Fragments for glycopeptides in the 
Edit Instrument settings to decrease the time required for 
complex glycan searches. For glycopeptide analysis of CID 
data, enable Glycan Fragments for better MS/MS coverage.
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Peptide Mapping: Crosslinks (1)
Crosslinks tab:
• For reduced samples: Set Connectivity to None.

• For non-reduced samples, do one of the following:
1. Set Connectivity to Fixed. 
‒ Use the correct syntax to enter the known disulfide bonds: enter the type of crosslink, 

and then the protein and amino acid position for each bond.
• For example: Disulfide[HC:22, HC:96] or Trisulfide[HC:371, LC:194] 
• The chain names must be identical to those specified in the Sequence tab.
• Different crosslinks cannot contain the same location.

‒ Enter the number of crosslinked peptides to include in the search.
• A Max. Peptides value of 3 or more increases the search time.

2. Set Connectivity to De Novo. 
‒ Use the + icon to select the crosslinkers of interest.
‒ Enter the number of crosslinked peptides to include in the search.

• A Max. Peptides value of 3 or more increases the search time.

‒ Enter the expected bonds in the Crosslinks tab of Automatic Review.
Note: For more information, refer to the page: Automatic Review: Crosslinks in this section (A: 2. 
General Guidelines for Peptide Mapping Workflows).

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Peptide Mapping: Crosslinks (2)
The De Novo search can take a long time to complete and create a large number 
of possible crosslinked peptides. For the search to start, the number of possible 
crosslinked candidates cannot be more than the threshold of 2.5 million. 

• The following Peptide Mapping parameters have an effect on the number of 
Crosslink Candidates:

‒ Crosslinks tab:
• Max. Peptides: Enter the maximum number of peptides in a complex.

‒ A Max. Peptides value of 3 or more increases the search time.

‒ Sequence tab:
• Max. Missed Cleavages: Enter the maximum number of missed cleavages in a peptide.

‒ In a crosslinked complex, each individual peptide can have up to this number of missed 
cleavages.

• Min. Length: Enter the minimum length of a feature.
‒ In a crosslinked complex, the minimum length is the total length of all peptide chains. For 

example, the crosslinked complex XX=XXXXX has a length of 7.

• Max. Peptide Length: Enter the maximum length of a peptide in a complex.
‒ In a crosslinked complex, the maximum length is the length of each individual peptide. 

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Automatic Review: Ambiguous Annotations

• Use Automatic Review to define the criteria to highlight Peptide Mapping 
results that require manual inspection. 
‒ Information is added to the Flag or Comment columns for the applicable entries 

in the Peptide Table in Review Results. 

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

General tab:
• To add Ambiguous annotation to the Comment column in the Peptide Table for 

features that have multiple annotations, select Detect Ambiguous Annotations.

Note: For more information on this example, refer to the page: Review Results: Isomer 
Differentiation in this section (A: 2. General Guidelines for Peptide Mapping Workflows). 
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Automatic Review: Modification RT Windows
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• To automatically reject peptides that do not 
meet the specified criteria, select Auto-reject.

1. Select the modifications to monitor with Automatic Review.
‒ Note: Deamidated and Deamidated (IsoAsp) are two separate modification entries 

in the dialog. 

2. Enter a time window when a modified peak must be detected in relation to 
the unmodified peak.

‒ Valid Modification RT Window: Modified peaks with a RT outside of this window 
have a Q (Questionable) in the Flag column and information added to the 
Comment column.

‒ Invalid Modification RT Window: Modified peaks with a RT inside this window 
have a Q (Questionable) in the Flag column and information added to the 
Comment column.

Modification RT Windows tab:
• To see the list of available modifications, use the + icon to open the Select 

Entries dialog.
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Automatic Review: MS/MS Coverage 
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

MS/MS Coverage tab:
• Min. Fragment Coverage: Enter a minimum peptide MS/MS coverage.

‒ Peptides with MS/MS coverage below the threshold have a Q flag and the comment 
MS/MS coverage below XX% in the Peptide Table of Review Results. 

• Modified Fragments Requirement: Select the level of MS/MS fragment ion 
evidence that is required to validate peptides with Variable modifications. 
‒ Strict: Requires evidence of MS/MS ions on both sides of a modified amino acid. 

• Variable modifications that do not meet this criterion have a Q flag and the comment 
Modified fragments (strict) not found in the Peptide Table of Review Results. 

‒ Relaxed: Requires evidence of MS/MS ions on one side of a modified amino acid. 
• Variable modifications that do not meet this criterion have a Q flag and the comment 

Modified fragments (relaxed) not found in the Peptide Table of Review Results. 
‒ None: Requires no evidence of MS/MS fragment ions on either side of a modified 

amino acid. Select this option to accept all modified peptides.• To automatically reject peptides 
that do not meet the specified 
criteria, select Auto-reject. Modified peptides have either Present 

(Strict) or Present (Relaxed) in the 
Modified Fragments column in the 
Fragment Spectra Table.



34 of 85 © 2024 DH Tech. Dev. Pte. Ltd.

Automatic Review: MS/MS Coverage 
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

MS/MS Coverage tab:
• IsoAsp Signature Ion Pair Required: Select this option if peptides that 

contain Asp→IsoAsp or Deamidated (IsoAsp) modifications must have at 
least one of the signature fragment ion pairs (c and c+57, or, z and z-57) 
identified. 
‒ Signature ion pairs include all relevant c or z class ions, for example,  z+1, z+1-57, 

z+1, z-57. 
‒ Peptides that do not meet this criterion have a Q flag and the comment IsoAsp 

signature ion pair not found in the Peptide Table of Review Results. 
‒ Relevant peptides have either Present or Absent in the IsoAsp Signature Ion Pair 

column in the Fragment Spectra Table.

• To automatically reject peptides 
that do not meet the specified 
criteria, select Auto-reject.
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Automatic Review: Isomer Detection 
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Isomer Detection tab:
• Select this option to add an I (Potential Isomer) flag to peptides that 

have identical annotations but different Group IDs. This indicates the 
presence of potential isomers for manual review.
‒ Required Amino Acids: Enter the single letter code for amino acids that 

must be in a peptide for it to be identified as an isomer candidate.
‒ Ignore Modified Peptides: Select this option to ignore isomer 

candidates that contain modifications.
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Automatic Review: Crosslinks
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Crosslinks tab:
• Select Flag Scrambled Crosslink Bonds to add a ≠ flag and the 

comment Contains unexpected crosslink bonds to the Peptide Table in 
Review Results. 
‒ Expected Bonds: Use the correct syntax for the known disulfide bonds. 

Enter the type of crosslink, and then the protein and amino acid position 
for each bond.
• For example: Disulfide[HC:22, HC:96] or Trisulfide[HC:371, LC:194] 
• The protein names must be identical to those in the Sequence tab.
• Different crosslinks cannot contain the same location.

Note: In Biologics Explorer Software 5.0, peptide mapping results of crosslinked peptides with Modification RT Windows flags should 
be manually assessed. Auto-Reject should not be selected.
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Review Results: Configure Settings
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Sequence tab:
• Sequence(s): 

‒ To use the sequence information specified in the previous Peptide 
Mapping activity nodes, select From Data.

Modifications tab:
• Select the Fixed modifications specified in the previous Peptide Mapping 

activity nodes.
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Review Results: Create Custom Layouts

• Each pane can be undocked and then 
docked at a new location.

• The location where the pane will be 
docked is highlighted by a blue box.

• To move useful tables and visualizers to 
the Peptides tab:

1. To undock the Data tab, click the     icon.
2. To undock any pane from the Data tab window, 

drag it to a new location on the Peptides tab.

• Favorite layouts can be saved and opened 
with the Layout icon.

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Click to undock the Data tab window.

Click to save the active layout or to open a saved layout.

Click to Synchronize Zooms across different tabs.

Note: For more information, refer to the document: 
Biologics Explorer Software Quick Guide.
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Review Results: Review Peptide Mapping Results

• Open the Review Results activity node to review the combined results of the 
preceding Peptide Mapping activity nodes.

1. Activate the Review mode, and then 
Accept or Reject annotations.
‒ To add a comment, either type in the 

applicable row in the Comment 
column, or use the      icon to add the 
same comment to multiple rows. 

2. To apply the changes, click the 
Save icon, and then select Save 
and Reload.

The activity node then automatically 
updates the peptide Quantities table.

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Review Results: Isomer Differentiation
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• MS/MS analysis with EAD creates diagnostic internal fragment ions that help to 
identify different isomeric amino acid residues. 

∆-29 Da ∆-43 Da

Deamidated asparagine (IsoAsp)Aspartic acid → IsoAsp

Isoleucine Leucine
‒ Leucine (Leu) or isoleucine (Ile):

• Ions are annotated as: wn or wnb.
‒ Leucine: wn ion at a 43 Da mass shift from the corresponding z  

(or z+1) ion.
‒ Isoleucine: wn ion at a 29 Da mass shift from the corresponding z 

(or z+1) ion.

‒ Isoaspartic acid (IsoAsp):
• Ions are annotated as: cn+57 or zm-57 (or zm+1-57).
‒ cn+57 or zm-57 ions in the MS/MS spectra identify isoaspartic acid. 
‒ Aspartic acid does not have these diagnostic internal fragment 

ions because the peptide backbone does not have a methylene 
group.
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Review Results: Isomer Differentiation
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• To see alternative identifications for the same peptide, use 
Keep: By Rank and Maximum Rank: 2 in the settings for 
Peptide Mapping.

• For data review in the Peptide Table in Review Results:
1. Click the Group Id column header to order entries numerically. 

Ambiguous annotations have the same Group Id.
• Select Detect Ambiguous Annotations in Automatic Review, to add 

information to the Comment column.

2. Use the diagnostic fragment ions in the MS/MS spectra to 
validate identifications.

• To add information about diagnostic fragment ions to the Comment 
column in the Peptide Table, select IsoAsp Signature Ion Pair 
Required in Automatic Review.

3. Select Accept or Reject for each result as required.

4. To apply the changes, click the Save icon, and then select 
Save and Reload.
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Export and Report Results
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• The exported PDF Report includes:
‒ A PDF document. 
‒ An embedded Excel file.
‒ An embedded workflow file (xml) that includes all of the settings.

• To open the xml file, drag the saved PDF Report into the workflow home page in the 
Biologics Explorer software.

Note: For more information, refer to the document: Biologics Explorer Software Quick 
Guide.

• There are three types of activity nodes to report or export 
results at the end of a workflow:
• Save Results Snapshot: Reviewed results are saved as sbf files 

that can be opened in the Pepmap_ReviewSnapshots workflow.
• Export PDF Report: A summary of results is saved as a PDF.
• Export to SCIEX OS: Results are saved as txt files that can be 

used for applications that use the SCIEX OS software.
• Select or add the folders where the results will be stored.
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• To use a Save Snapshot activity node to save intermediate results:
‒ Deactivate the Block icon.
‒ Select or add the folders where the sbf files will be stored.

• The Save Snapshot activity nodes save intermediate results at different stages of a workflow.
‒ An individual sbf file is saved for each sample processed in the workflow.
‒ The sbf file contains the properties of the processed data that are required to continue analysis from that 

point in the workflow.

Export Intermediate Results for Further Analysis 
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS



44 of 85 © 2024 DH Tech. Dev. Pte. Ltd.

Use Intermediate Results for Further Analysis 
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

1. Open a suitable Peptide Mapping workflow. 
2. Select the sbf files to import into Load Raw Data.
3. Change the Format to Snapshot (*.sbf) or Auto Detect. 
4. Activate the Bypass icon on the activity nodes in the workflow 

that are before the Snapshots were saved.
• For example: To load sbf files from Save Clusters+Groups 

Snapshot, activate the Bypass icon for all activity nodes between 
Load Raw Data and MS/MS Consolidation.

• To continue data analysis with saved Snapshots, such as 
those from in the Data Preparation [Container]:
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Export PDF Report
A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• The output of Export PDF Report includes:
‒ A PDF document.
‒ An optional Excel file.
‒ An embedded workflow file (xml) that includes all of the settings.

• To open the xml file, drag the saved PDF Report into the workflow home page in the Biologics 
Explorer software.

• Note: For more information, refer to the document: Biologics Explorer Software Quick Guide.

• General tab: Enter the name and saved location of the 
exported report.

• Template tab: Use the Edit Selection icon to select the 
Elements to be included in the report.
‒ Select only columns of interest in reported tables. The 

layout of the tables is controlled by the number of columns.

• Excel tab: Use the Edit Selection icon to select the 
Tables to be included in the report.
‒ All columns in a selected table are reported.
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Export to SCIEX OS

Note: The modification position exported with the Export to SCIEX OS activity 
node is relative to the peptide, not the protein. For example, DTL[M]ISR would 
be M4, not M255.  

A: 2.GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

• The Export to SCIEX OS activity node should not be used in 
combination with the Wildcard Mapping activity node.
‒ Activate the Bypass icon on the Wildcard Mapping activity node 

when required.

• General tab:
‒ Enter the name and saved location of the exported report.
‒ Select the requirements of the export, for example, the number of clusters 

for each group, and if adducts are to be included.
‒ Use Observable: Volume for data acquired using a QTOF mass 

spectrometer.

Export to SCIEX OS creates a txt file of peptide mapping data that can be 
imported into the SCIEX OS software for further data processing.
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Part B
Guidelines for Specific Peptide Mapping 
Workflows
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WORKFLOW SPECIFIC INFORMATION AND GUIDELINES

1. Simple Peptide Mapping
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Simple Peptide Mapping Workflow
B: 1.GUIDELINES FOR SIMPLE PEPTIDE MAPPING WORKFLOWS

• Use this workflow for routine analysis 
of non-complex biotherapeutic 
molecules.

• Edit the combination of search 
parameters in the Peptide Mapping 
activity node to identify peptides and 
modifications, including glycosylation.

Pepmap_Simple_Be5.0
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WORKFLOW SPECIFIC INFORMATION AND GUIDELINES

2. Extended Characterization
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Extended Peptide Mapping Workflow
B: 2.GUIDELINES FOR EXTENDED PEPTIDE MAPPING WORKFLOWS

• Use this workflow for a more 
comprehensive Peptide Mapping 
analysis of biotherapeutic molecules.

• Combine results from up to three 
consecutive Mapping activity nodes to 
extend the search space and increase 
identifications, but keep false positives 
to a minimum.

Pepmap_Extended_Be5.0
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Peptide Mapping 1
‒ To identify the most likely peptides and modifications.

Peptide Mapping 2
‒ To search for less common modifications.
‒ Ignore Annotated Features: Makes sure that only unannotated features 

from the previous search are considered.
• Example Use Case: For biotherapeutics with N- and O-glycosylation, false positives 

are decreased when Peptide Mapping 1 is used to identify N-glycans, and Peptide 
Mapping 2 is used to identify O-glycans.

Wildcard Mapping
‒ To search for unexpected modifications.

• Add identified modifications to a Peptide Mapping activity node.
• Activate the Bypass icon when Wildcard Mapping is not required.

Extended Characterization
B: 2.GUIDELINES FOR EXTENDED PEPTIDE MAPPING WORKFLOWS

• This workflow uses up to three consecutive search nodes to extend the 
search space but minimize false positives:
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Step-Wise Peptide Mapping: Application Example
B: 2.GUIDELINES FOR EXTENDED PEPTIDE MAPPING WORKFLOWS

Peptide Mapping 1
• Sequence tab. Enzymes: Fully specific (Trypsin).
• Modifications tab: Abundant and most likely modifications.

Peptide Mapping 2
• Sequence tab. Enzymes: Semi-specific (SemiTrypsin).
• Modifications tab: Shorter list of most likely modifications. 
Or:
• Sequence tab: Enzymes - Fully specific (Trypsin).
• Modifications tab. Alternative set of less common 

modifications that might be present at low abundance. 

Wildcard Mapping
• Select All Peptide Candidates for annotations related to 

unknown modifications.

• Suggested settings for this type of analysis:

• Comprehensive post translational modification (PTM) analysis.
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WORKFLOW SPECIFIC INFORMATION AND GUIDELINES

3. Sequence Variant Search
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SVA Peptide Mapping Workflow
B: 3.GUIDELINES FOR SEQUENCE VARIANT ANALYSIS WORKFLOWS

• Use this workflow to detect potential sequence 
variants.
‒ Note: High quality MS and MS/MS data is 

required for confident identification of sequence 
variants. Instrument acquisition should be 
optimized for SVA.

• Two consecutive Peptide Mapping activity 
nodes identify the non-variant peptides and 
remove them from the search space.
‒ Note: For more information about step-wise 

Peptide Mapping, refer to the section: B: 
2.Guidelines for Extended Peptide Mapping 
Workflows.

• A further Peptide Mapping with SVA activity 
node searches for sequence variants. 

• Possible SVA identifications can be compared 
with the results from the Wildcard Mapping 
activity node for verification.Pepmap_SVA_Be5.0
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SVA Peptide Mapping Workflow
B: 3.GUIDELINES FOR SEQUENCE VARIANT ANALYSIS WORKFLOWS

To detect potential sequence variants:
1. Use Peptide Mapping 1 and Peptide Mapping 2 to complete a typical analysis for non-variant peptides. 

• Refine the Peptide Mapping settings for the molecule under investigation. 
Note: For more information about step-wise Peptide Mapping, refer to the section: B: 2.Guidelines for Extended Peptide 
Mapping Workflows.

→ Identified peptides are removed from the search space, which decreases false positives in the next stage. 

2. Complete an initial review of the data. 
• Click the Save icon, and then click Save and Reload.

→ Features from the rejected annotations are considered again in the Peptide Mapping with SVA search.

Note: For settings information for identification of low abundance peptides, refer to the pages: MS/MS Peak Detection and 
MS/MS Deisotoping in A: 2.General Guidelines for Peptide Mapping Workflows.

4. Compare identifications in Peptide Mapping with SVA and Wildcard Mapping.
5. Review, and then Accept and Reject entries in the Peptide Table as required.

3. Deactivate the Pause icons on the Peptide Mapping with SVA and Wildcard Mapping 
activity nodes, and then click the Play icon to run them.
• To increase the number of possible identifications, decrease the Min. Score in Peptide Mapping with 

SVA and Wildcard Mapping. A lower Min. Score increases the false positives for review. Manually 
review identifications that are close to the Min. Score threshold to reject incorrect annotations



57 of 85 © 2024 DH Tech. Dev. Pte. Ltd.

WORKFLOW SPECIFIC INFORMATION AND GUIDELINES

4. Comparative Analysis
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Comparative Peptide Mapping Workflow
B: 4.GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

• Use this workflow to compare two sets of 
samples, for example:
‒ Reduced and non-reduced samples.
‒ Stressed and unstressed samples.
‒ A reference sample with samples from a new 

batch.

• Combine results from up to three 
consecutive Mapping activity nodes. 
‒ Note: For more information about step-wise 

Peptide Mapping, refer to the section: B: 
2.Guidelines for Extended Peptide Mapping 
Workflows.

• The Differential Analysis [Container] 
prepares data for comparisons to be made.

Pepmap_Comparative_Be5.0
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• The activity nodes connected with green lines contain statistical tools that can be used to compare two 
datasets.

• The workflow reports:
‒ The relative (%) abundance of peptides in each dataset.
‒ The peptides that are absent in one sample set, but present in the other.
‒ The peptides that have a specified fold-change difference between sample sets.

Comparative Peptide Mapping

The statistical activity nodes identify features that differ significantly 
between the two sample groups being compared in the workflow.

B: 4.GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS
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• Click the table icon to open the Metadata Editor.
• Enter the Group names for the files to be compared.

• Optionally, add a Color column and enter a color for each group.

Load Raw Data and Define Groups
B: 4.GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS
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Application Example 1: Disulfide Bond Analysis
B: 4.GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

Peptide Mapping 1
• Sequence tab. Enzymes: Fully specific (Trypsin).
• Disulfide tab. Connectivity: De Novo
• Modifications tab. Variable alkylation of cysteine.

Peptide Mapping 2
• Sequence tab. Enzymes: Semi specific (SemiTrypsin). 
• Disulfide tab. Connectivity: None.

Wildcard Mapping
• Select All Peptide Candidates for more annotations related to 

unknown modifications.

• Recommended settings for this type of analysis:

• Comparative analysis of reduced and non-reduced samples.

Note: For more information about step-wise Peptide Mapping, refer to the section: B: 2.Guidelines for Extended Peptide 
Mapping Workflows.
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Peptide Mapping 1
• Sequence tab. Enzymes: Fully specific (Trypsin).
• Modifications tab. Abundant and most likely modifications.

Peptide Mapping 2
• Sequence tab. Enzymes: Semi specific (SemiTrypsin).
• Modifications tab. Shorter list of most likely modifications. 
Or:
• Sequence tab. Enzymes: Fully specific (Trypsin).
• Modifications tab. Alternative set of less common modifications 

that might be present at low abundance. 

Wildcard Mapping
• Select All Peptide Candidates for annotations related to 

unknown modifications.

Application Example 2: Stress Tests and Variability
B: 4.GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

• Comparative analysis for stress testing and lot-to-lot variability.
• Recommended settings for this type of analysis:

Note: For more information about step-wise Peptide Mapping, refer to the section: B: 2.Guidelines for Extended Peptide 
Mapping Workflows.
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• Valid Feature Filter
‒ Removes any features below a set threshold, and any found in less than a 

set % or number of experiments.
‒ Removes insignificant differences or signal caused by noise or artifacts. If 

predicted peptides are not found, then optimize this setting.

• Data Setup 
‒ Prepares data in a matrix form for the next activity nodes.
‒ If groups were not defined in Load Raw Data, use Group: Manually and 

assign each sample to a group. 

• Feature Condensing
‒ Uses annotations to group features.
‒ Calculates a single intensity value for each of the created groups.

• Group Change
‒ Calculates relative and fold-change differences between experiments.
‒ If there are multiple experiments, then the reported change is the maximum 

difference between any two experiments.

Differential Analysis [Container]
B: 4.GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

Note: Available settings are related to 
the previous activity nodes. To see the 
list of possible Group by options, run 
Data Setup, and then edit the Feature 
Condensing settings.  
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Differential Analysis [Container]: Data Preparation

• To use annotations to combine the features in each group, and calculate a 
single intensity value for the combined feature, select the types of 
annotations to Group by in Feature Condensing.

‒ For example, to combine peptides with the same sequence and modifications, 
from the same protein, select: Protein, Peptide, and Modification. 

Group 1

• To define groups in the Data Setup activity node, select Group: Manually, 
and then assign each sample to a group.

‒ For example, Group 1 to Group 4 for lot-to-lot comparability:

B: 4.GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

Group 2 Group 3 Group 4

Note: To see the list of possible Group by options, run Data Setup, 
and then edit the Feature Condensing settings. 
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Normalization (% Abundance)

Protein Peptide Modification
Feature Condensing: Group by

100%

B: 4.GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

• Normalization (% Abundance)
‒ Percent Abundance: For each experiment, the values of all members of each group are 

added. Then, the value of each member of a group is divided by the corresponding total and 
multiplied by 100.
• If Group by is set to Peptide, then the Percent Abundance is calculated for each peptide. 
• If Group by is blank or set to Undefined, then the Percent Abundance is calculated for 

the whole sample. 

Normalization: Group by Peptide

100%
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Absent/Present and Highly Changing Features
B: 4.GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

• Highly Changing Features
‒ Set the required minimum fold change.

• Absent/Present 
‒ Compare features between two sample groups. 
‒ To filter the results, move the sliders in the input window 

that opens when the activity node is run. 
• For example, for disulfide bond analysis, the features of interest are 

likely to be Absent in the reduced sample and Present in the non-
reduced sample.
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Synchronize Selections for Simplified Data Review
B: 4.GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

Synchronize 
selection 

• To automatically update (dynamically link) the selection in all results windows:
1. Open the results windows for Absent/Present, Highly Changing Features and Review Results.
2. Click the Synchronize selection icon in Ion Map tab of Review Results.
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WORKFLOW SPECIFIC INFORMATION AND GUIDELINES

5. Peptide Mapping Batch Processing
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Peptide Mapping Batch Processing Workflow
B: 5.GUIDELINES FOR PEPTIDE MAPPING BATCH PROCESSING WORKFLOWS

• Use this workflow to analyze multiple 
samples independently, in an iterative 
manner. 

• Use the Pepmap_Extended workflow to 
optimize the workflow settings for any 
new samples before running a Batch 
Processing workflow. 

‒ Note: For more information about step-wise 
Peptide Mapping, refer to the section: B: 
2.Guidelines for Extended Peptide Mapping 
Workflows.

• Use the Pepmap_ReviewSnapshots 
workflow to review data and create 
reports for samples analyzed with the 
Batch Processing workflow.

Pepmap_BatchProcessing_Be5.0
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Recommendations for the Batch Processing Workflow
B: 5.GUIDELINES FOR PEPTIDE MAPPING BATCH PROCESSING WORKFLOWS

1. Use the Load Representative Raw Data activity node to first review a 
small number of representative samples.
‒ Examine the RT range and noise level.
‒ Use the Pepmap_Extended workflow to optimize the workflow settings 

for any new samples. 

2. Use a small RT Range Restriction, for example 10 min to 15 min, and 
a smaller sample set, so that the Batch Processing workflow contains 
all applicable metadata and completes successfully. 
‒ To monitor progress, double-click the icon to open the Log Messages 

dialog.

3. Use the Save Annotations Snapshot or Save Review Snapshot 
activity node to save Peptide Mapping results. Load each saved sbf 
file separately in the Pepmap_Review Snapshots workflow to review 
the results and create individual PDF reports. 

• To use the Batch Processing workflow:
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Batch Iterative Processing Container
B: 5.GUIDELINES FOR PEPTIDE MAPPING BATCH PROCESSING WORKFLOWS

Note: If activity nodes in the container have the Bypass icon activated, then 
the container shows a yellow warning symbol.

‒ Only intermediate results from the last sample to be processed can be 
opened from the activity nodes in the Batch Iterative Processing container.

Activity nodes in the Batch Iterative 
Processing container do not have 
a Run or Reset icon.

• The Batch Iterative Processing container is not the same as other Biologics Explorer software 
containers.

• To open the intermediate results of an activity node, 
deactivate the Trash icon before the workflow is 
started.

• Do not activate the Trash icon for Peptide Mapping 
activities that are used in the PDF Report.

• Individual activity nodes in the Batch Iterative 
Processing container cannot be run alone.
‒ To use a Save Snapshot or Export activity node in 

the Batch Iterative Processing container, deactivate 
the Block icon before the workflow is started.
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• To analyze replicate samples from different acquisition files:
1. Select Use File Name as Sample Name in Load Raw Data.

2. Use the File Name (name of the wiff or wiff2 container file) in the Experiment column 
of the txt file for Metadata Import. 

Load Raw Data: Experiment Names and Metadata
B: 5.GUIDELINES FOR PEPTIDE MAPPING BATCH PROCESSING WORKFLOWS

For more information, refer to the page: Load Raw Data: Use File 
Name as Sample Name in A: 2.General Guidelines for Peptide 
Mapping Workflows. 

• To analyze multiple samples from a single acquisition file:
1. Do not select Use File Name as Sample Name in Load Raw Data.

2. Use the Sample Name in the Experiment column of the txt file for Metadata Import.

File name

Sample names
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Metadata Import
B: 5.GUIDELINES FOR PEPTIDE MAPPING BATCH PROCESSING WORKFLOWS

• To analyze multiple samples with the same sequence:
‒ Deactivate the Trash icon, and then activate the Bypass icon for Metadata Import. 
‒ On the Sequences tab in Peptide Mapping, select From Text or From Fasta File.

• To analyze multiple samples with different sequences:
‒ Use Metadata Import to select the FASTA file (protein sequence) that will be used for 

identification in the Peptide Mapping activity nodes.

• Upload a txt file with Metadata Import that links each sample to the correct FASTA file.
‒ The name in the Experiment column must be the same as in the Experiment table in Load Raw Data.
‒ The name in the Fasta File column must be the same as the name of the FASTA file that is in the 

specified Fasta File Directory, including the file extension (fasta or txt).

Note: For more information, refer to the page: Review Results: Protein Name in FASTA Files in B: 5.Guidelines for 
Peptide Mapping Batch Processing Workflows.
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Metadata Import: How to Create the Metadata File 
B: 5.GUIDELINES FOR PEPTIDE MAPPING BATCH PROCESSING WORKFLOWS

• To create the metadata file in Excel or Notepad:
1. Select the samples for batch processing in Load Raw Data.
2. Open the Metadata Editor table.
3. Select all of the entries in the Metadata Editor table, and then 

select copy.
4. Paste the entries into the Experiment column of the metadata 

txt file.
• Delete “.wiff” or “.wiff2” from the end of each name. (Tip: Use the 

Replace command in Excel or Notepad.)

5. Type the applicable FASTA file name in each row in the Fasta 
File column.

6. Save the file in txt format, and then upload the file in the 
Metadata Import activity node.

Note: Any metadata added in the Load Raw Data 
Metadata Editor table must be completed for all 
rows (all samples).

(2)

(4)

(3)
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• To identify the RT ranges where there is meaningful data, open (double-click) 
Load Representative Raw Data after the data is loaded.

Restrict the RT Range
B: 5.GUIDELINES FOR PEPTIDE MAPPING BATCH PROCESSING WORKFLOWS

• Use the Load Representative Raw Data activity node to review a 
small number of representative samples outside of the Batch 
Iterative Processing container.

Note: If the fields are blank, or if RT 
Range Restriction has the Bypass 
icon activated, then the full RT 
range is used.

• If the RT ranges are consistent across all samples, then deactivate the                          
Bypass icon and enter RT Minimum and RT Maximum values in the RT Range 
Restriction activity node in the Batch Iterative Processing container.
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Peptide Mapping: Sequence tab

Sequence tab:
• Sequence(s): 

‒ If all samples have the same sequence, then select From Text and type 
the sequence, or From Fasta File and select the applicable file.

‒ If different samples require different sequences, then select From 
Metadata: Fasta File, Sequence IDs (optional), and then browse to 
the location of the folder that contains all of the applicable FASTA files.

B: 5.GUIDELINES FOR PEPTIDE MAPPING BATCH PROCESSING WORKFLOWS

• Enzymes: 
‒ Adjust enzyme specificity, maximum number of missed cleavages, 

and minimum peptide length as required.
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Review Results: Protein Name in FASTA Files

• If the protein sequence names are unique across the 
FASTA files used for identification:

B: 5.GUIDELINES FOR PEPTIDE MAPPING BATCH PROCESSING WORKFLOWS

‒ The protein sequence 
name in Review Results is 
the same as the name in 
the FASTA file.

• If the protein sequence names are not unique across 
the FASTA files used for identification:

‒ The protein sequence 
name in Review Results 
includes the FASTA file 
name.
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Export PDF Report

• There are two locations to save a PDF Report in the Batch Processing workflow:

B: 5.GUIDELINES FOR PEPTIDE MAPPING BATCH PROCESSING WORKFLOWS

• To create individual reports of reviewed results:
1. Use either Save Annotations Snapshot in the Batch Iterative Processing container, or 

Save Review Snapshot out of the Batch Iterative Processing container to save Peptide 
Mapping results.

2. Review the sbf files separately in the Pepmap_ReviewSnapshots workflow.
3. Use Export PDF Report in the Pepmap_ReviewSnapshots workflow to create one 

report per sample.

1. Export PDF Report per Sample, in the Batch Iterative Processing 
container.

• Creates a report for each sample, that contains the results from the 
Peptide Mapping activity nodes, before review.

2. Export Summary Report, out of the Batch Iterative Processing 
container.

• Creates a report that contains the sequence coverage results for all 
samples from the Review Results activity node and any warnings from the 
workflow.
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WORKFLOW SPECIFIC INFORMATION AND GUIDELINES

6. Review Snapshots



80 of 85 © 2024 DH Tech. Dev. Pte. Ltd.

Review Snapshots Workflow
B: 6.GUIDELINES FOR REVIEW SNAPSHOTS WORKFLOWS

• Use this workflow to review saved 
Snapshot results that have peptide 
annotations.
‒ For example, to review individual results 

Snapshots from the Batch Processing 
workflow and create a report.

Pepmap_ReviewSnapshots_Be5.0
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• When multiple samples are analyzed in the other Peptide 
Mapping workflows, each sample creates its own sbf file.
‒ To load saved sbf files into the Pepmap_ReviewSnapshots 

workflow, select all of the individual sbf files in the parent folder.
‒ Data will not load if the parent folder is selected. 

Review Saved Results
B: 6.GUIDELINES FOR REVIEW SNAPSHOTS WORKFLOWS

• The Review Results activity node opens a copy of the 
previous analysis.
‒ Any previously accepted or rejected peptides have the 

applicable entry in the Flags column.
‒ A further review is then possible. 
‒ The reviewed sbf files and a new report can be saved.
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• Special Use Case: To combine samples with different sample preparation methods that 
have been processed in different Peptide Mapping workflows.
‒ For example: Samples of the same molecule that have been digested with different enzymes, and 

then analyzed separately using a Peptide Mapping workflow.

Load Snapshots: Metadata  
B: 6.GUIDELINES FOR REVIEW SNAPSHOTS WORKFLOWS

1. On the General tab, click the icon to open the Metadata Editor.
2. Add a column called Data Set. 

‒ Note: Spaces and capitalization are critical. For example, Data set will not work.

• The overall Sequence Coverage takes all of the samples into account.



83 of 85 © 2024 DH Tech. Dev. Pte. Ltd.

Review Results: Configure Settings
B: 6.GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Sequence tab:
• Sequence(s): 

‒ If sbf files were saved from data analyzed with Biologics Explorer 
software 4.0, then select From Data.

‒ If sbf files were saved from data analyzed with Biologics Explorer 
software 3.1 (or earlier versions), then:
• If all samples have the same sequence, then select From Text and type the 

sequence, or From Fasta File and add the applicable file.
• If different samples require different sequences, then select From Metadata: 

Fasta File, Sequence IDs (optional). 
• Note: For more information about Batch Processing, refer to the section: B: 

5.Guidelines for Peptide Mapping Batch Processing Workflows.

Modifications tab:
• Select the Fixed modifications specified in the previous Peptide Mapping 

activity nodes.



84 of 85 © 2024 DH Tech. Dev. Pte. Ltd.

For more information, visit the 
SCIEX website at sciex.com, or 
contact us in one of the following 
ways:

sciex.com/contact-us
sciex.com/request-support



85 of 85 © 2024 DH Tech. Dev. Pte. Ltd.

Trademarks / Licensing

The SCIEX clinical diagnostic portfolio is For In Vitro Diagnostic Use. Rx Only. 
Product(s) not available in all countries. For information on availability, please 
contact your local sales representative or refer to https://sciex.com/diagnostics.  
All other products are For Research Use Only. Not for use in Diagnostic 
Procedures. 

Trademarks and/or registered trademarks mentioned herein, including 
associated logos, are the property of AB Sciex Pte. Ltd. or their respective 
owners, in the United States and/or certain other countries (see 
sciex.com/trademarks). 
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